
AAtthheennaa  VViissuuaall  SSttuuddiioo  VViissuuaall  KKiinneettiiccss  TTuuttoorriiaall  
 
VisualKinetics™ is an integrated tool within the Athena Visual Studio software environment, 
which allows scientists and engineers to simulate the dynamic behavior of homogeneous and 

heterogeneous chemical 
reactions. Chemical 
reactions may include but 
not limited to, microbial 
growth kinetics, 
pharmacokinetics, food 
preparation kinetics, 
enzymatic reactions, and 
combustion reactions and 
many more. In addition 
VisualKinetics™ allows 
the user to perform 
sensitivity analysis and 
compare simulation results 
with experimental data in 

order to estimate unknown parameters. Rigorous statistical methods based on Bayes’ theorem 
and implemented in VisualKinetics™ allow for model criticism and lack-of-fit analysis, rival 
model discrimination as well as optimal experimental design. More specifically, the following 
tasks are implemented in VisualKinetics™ 
 
Modeling of Complex Reaction Networks: Allows the user to design and build reaction 
network, by entering species, reactions, kinetic and adsorption parameters and miscellaneous 
other operating conditions either via a graphical user interface or a text file.  Athena compiles the 
user information and creates a subroutine named by the user; this subroutine is written in 
FORTRAN 95 and it is callable form compatible environments. 
 
Reactor Modeling: Allows the user to design and build reactor models, by entering species, 
reactions, kinetic and adsorption parameters and miscellaneous other operating conditions either 
via a graphical user interface or a text file. The reactor models available through the interface are 
Batch, Semi-Batch, and Continuous Stirred Tank Reactors, Plug Flow and Fixed Bed Reactors. 
The reactor models can be isothermal, adiabatic or non-isothermal. 
 
Simulation: Once the kinetic model is implemented and the proper data entered, 
VisualKinetics™ generates the required interface to the Athena Visual Studio computational 
engines in order to perform various simulation studies and investigate the dynamic and steady 
state behavior of the chemical species. In this mode the user can exploit the rich environment of 
Athena Visual Studio and perform sensitivity analysis and parametric continuation studies. 
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Statistical Analysis and Nonlinear Parameter Estimation: This unique feature of 
VisualKinetics™ permits the user to set up parameter estimation problems via the graphical 
interface. In this setup the user brings the experimental data, and easily selects the model 
responses and parameters that need to be estimated. VisualKinetics™ then creates the proper 
interface to Athena Visual Studio’s statistical analysis engines, such as weighted Least Squares 
and Bayesian Estimation techniques. A large number of tools are now available to the user, for 
statistical inferences on the model parameters, model discrimination and lack-of-fit as well 
optimal experimental design. 
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TTuuttoorriiaall::    BBeennzzeennee  OOxxiiddaattiioonn  IIssootthheerrmmaall  BBaattcchh  RReeaaccttoorr  
 
Reaction Mechanism and Reaction Rates: 
 
The production of maleic anhydride by the oxidation of benzene in the presence of excess air is 
given by the following reaction mechanism:  
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The values and description of the parameters for this process are given in the table below: 
 

MODEL PARAMETERS INITIAL CONDITIONS 

1
126604280.0 expk

T
⎛ ⎞= × −⎜ ⎟
⎝ ⎠

 6 6 (0) 10.0C H =  

2
1500070100.0 expk

T
⎛ ⎞= × −⎜ ⎟
⎝ ⎠

4 2 3 (0) 0.0C H O =  

3
1080026.0 expk

T
⎛ ⎞= × −⎜ ⎟
⎝ ⎠

 2 (0) 40.0O =  

6 6
0.5C HK =  2 (0) 0.0CO =  

 ( )2 0 0.H O = 0  

 
We wish to develop a reactor model called VKBatchReactor that would accept input by the user 
and perform a dynamic simulation of the process, yielding the species concentration profiles as a 
function of time.  
 
This example tutorial is already precoded in Athena Visual Studio. If you do not wish to type the 
code on your own you may access it by doing the following: 
 
� Open Athena Visual Studio 
� From the File menu click Open 
� Navigate to \Athena\Samples\Visual Kinetics folder 
� Select the VKBatchReactor.avw sample 
� Click OK 
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IImmpplleemmeennttaattiioonn  iinn  AAtthheennaa  VViissuuaall  SSttuuddiioo  
 
The following step by step process describes the model implementation in Athena Visual Studio 
 

CCoommppoonneenntt  SSeelleeccttiioonn  
 
� Open Athena Visual Studio.  
� From the VisualKinetics menu, choose Batch Reactor 
� Enter a File name in the New Model File Dialog box and then Click Save.  
� The Visual Kinetics Control Panel appears.  
� You are now in the Component Selection tab. 
 

 
 
� Search for and Add… the reaction components [C6H6,C4H2O3,O2,CO2,H2O]. Click New… 

if you wish to add a user component that is not in the Athena Database. 
� When you complete the selection of the reaction components click Submit. This action 

activates the Reaction Mechanism and Reaction Rate Data tabs. The Operating Data tab also 
is enabled in order to enter miscellaneous component properties and the reaction 
temperature and pressure.  
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RReeaaccttiioonn  MMeecchhaanniissmm  
 
� Select the Reaction Mechanism tab. 
 

 
 
� Formulate and Add the chemical reactions by selecting the Reactants and the Products from 

the drop down lists. Select blank from the drop down list if you wish to delete a component 
from a particular reaction. Use the Insert, Modify and Remove command buttons to edit 
your reaction scheme. 

� Modify, if necessary, the stoichiometric coefficients (as indicated in this example). By 
default Athena assumes elementary reactions and therefore the stoichiometric coefficients 
can be the integers 1, 2 or 3. Should you wish to modify these coefficients to accommodate 
overall reaction mechanisms, such as cracking to miscellaneous components, you may do so 
by exporting your model into a data file, modifying the reaction rates and then re-importing 
the mechanism back into Athena. 

� Use the Clear command button if something went wrong and you wish to start from the 
beginning. 
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RReeaaccttiioonn  RRaattee  DDaattaa  
 
� Select the Reaction Rate Data tab. 
 

 
 
From the Reaction Rate Constant Input Options group, select the form of the reaction rate 
constants (in our example, Frequency Factor and E/R) and enter their numerical values. You 
may wish to enter values for the equilibrium constant if you have selected a reaction that is 
reversible; you may also wish to enter the adsorption terms for a heterogeneous reaction as 
indicated in this example.  Recall that the general form of the reaction rate constants, equilibrium 
constants and species adsorption constants in Athena is given by the following equations:  
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Modify, if necessary, the reaction rate form by clicking on the reaction rate you wish to modify, 
entering the corrections in the yellow text box and then clicking OK to accept the rate changes. 
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BBaattcchh  RReeaaccttoorr  DDaattaa  
 
� Select the Batch Reactor tab. 
 

 
 
� Enter the Initial Concentrations of all chemical species of the reaction mixture. 
� Enter, if necessary, the numerical values of the species adsorption constants. 
� Enter the Reaction Time, Temperature and Reaction Pressure. 
� Click OK 
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SSiimmuullaattee  tthhee  BBaattcchh  RReeaaccttoorr  
 
You are now ready to save your Batch Reactor model and run it. In order to save your project: 
 
� From the File menu, choose Save. The Save As dialog box appears. This action saves 

your model and creates the Fortran code. 
� In the Directories box, double-click a directory where you want to store the source file of 

your project. 
� Type a filename (a filename cannot contain the following characters: \ / : * ? “ < > |) in 

the File Name box, then choose OK. The default extension is avw  
� To view the Fortran code that you created from the View menu choose Fortran Code. 

  
You may now choose to compile, build and execute your project; to do that: 
 
� From the Build menu choose Compile (or Hit F2) 
� From the Build menu choose Build EXE (or Hit F4) 
� From the Build menu choose Execute (or Hit F5) 
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NNuummeerriiccaall  RReessuullttss  
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process: 
 
 Number of State Equations.......................     5 
 Number of Sensitivity Parameters................     0 
 Number of Integration Output Points.............    22 
  
  TIME          U(1)          U(2)          U(3)          U(4)          U(5) 
  0.00000E+00   1.00000E+01   0.00000E+00   4.00000E+01   0.00000E+00   0.00000E+00 
  5.71429E+00   9.97838E+00   2.05459E-02   3.98995E+01   4.75484E-02   4.43201E-02 
  1.14286E+01   9.95676E+00   4.10375E-02   3.97988E+01   9.52679E-02   8.86714E-02 
  1.71429E+01   9.93516E+00   6.14739E-02   3.96981E+01   1.43161E-01   1.33054E-01 
  2.28571E+01   9.91356E+00   8.18552E-02   3.95973E+01   1.91227E-01   1.77469E-01 
  2.85714E+01   9.89197E+00   1.02181E-01   3.94963E+01   2.39467E-01   2.21915E-01 
  3.42857E+01   9.87039E+00   1.22452E-01   3.93952E+01   2.87880E-01   2.66392E-01 
  4.00000E+01   9.84881E+00   1.42667E-01   3.92941E+01   3.36468E-01   3.10901E-01 
  4.57143E+01   9.82724E+00   1.62827E-01   3.91928E+01   3.85229E-01   3.55442E-01 
  5.14286E+01   9.80568E+00   1.82932E-01   3.90914E+01   4.34164E-01   4.00014E-01 
  5.71429E+01   9.78413E+00   2.02980E-01   3.89899E+01   4.83273E-01   4.44617E-01 
  6.28571E+01   9.76259E+00   2.22974E-01   3.88884E+01   5.32557E-01   4.89252E-01 
  6.85714E+01   9.74106E+00   2.42911E-01   3.87867E+01   5.82015E-01   5.33918E-01 
  7.42857E+01   9.71953E+00   2.62793E-01   3.86849E+01   6.31647E-01   5.78616E-01 
  8.00000E+01   9.69801E+00   2.82618E-01   3.85829E+01   6.81454E-01   6.23346E-01 
  8.57143E+01   9.67650E+00   3.02388E-01   3.84809E+01   7.31436E-01   6.68106E-01 
  9.14286E+01   9.65500E+00   3.22102E-01   3.83788E+01   7.81592E-01   7.12899E-01 
  9.71429E+01   9.63351E+00   3.41760E-01   3.82766E+01   8.31924E-01   7.57722E-01 
  1.02857E+02   9.61202E+00   3.61362E-01   3.81742E+01   8.82430E-01   8.02577E-01 
  1.08571E+02   9.59054E+00   3.80908E-01   3.80718E+01   9.33112E-01   8.47464E-01 
  1.14286E+02   9.56907E+00   4.00397E-01   3.79692E+01   9.83969E-01   8.92381E-01 
  1.20000E+02   9.54761E+00   4.19830E-01   3.78666E+01   1.03500E+00   9.37331E-01 
  
 EXIT DDAPLUS: SOLUTION FOUND            
  
 Number of Steps Taken Thus Far...................       18 
 Number of Function Evaluations...................       72 
 Number of Jacobian Evaluations...................        6 
 Number of Jacobian Factorizations................        6 
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GGrraapphhiiccaall  RReessuullttss  
 
If you wish to see the time profiles for all the species that participate in this fermentation process 
from the View menu choose Solution Graphs. The Athena Visual Studio graphics control panel 
appears: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Time) and the y-variable (here two of the state variables by 
holding the Ctrl key down and clicking with your mouse on the two variables) and click Graph. 
You should see the graph that appears above. You may now click on the graph toolbar and 
modify the type, title, symbol, the style and miscellaneous other properties of the graph. 
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